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Confidentiality 
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Introduction 

 

Purpose 

The purpose of this document is to detail core functionality and usage of CRIS Analytics in context to Radiology. 

 

Audience 

The intended audience for this document is anyone engaged in reviewing or using CRIS Analytics. 
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CRIS Analytics - EXPLORE 
 

Analytics is a browser-based application. There are two screens: EXPLORE, where you can view and edit charts, and 

CREATE, where (if you are an administrator) you can configure categories (dashboards), roles, and users. 
 

1.1 OVERVIEW 
 

Analytics takes information from the CRIS (Radiology Information System) database and produces easy-to-read 

charts displaying, for example, current waiting times in the department, or number of outstanding reports.  
 

 

 

 

Analytics displays a selection of related (e.g. waiting times) charts on customised dashboards. See 1.3 DASHBOARDS 

 

 
 

Charts can be filtered, enabling you to display more detailed information. Most charts also allow you to ‘drill 
down’ into the chart to view the raw data i.e. individual patient records. See 1.6 FILTERS 
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1.2 LOG IN 
 

When you go to the Analytics EXPLORE URL, the Login dialog appears. When you first log in, you may be asked to 

enter a new password. Passwords must be at least 6 characters long. NOTE: Passwords are case sensitive. 
 

 
 

 If you enter incorrect login details more than once, it will tell you how many times you have been unsuccessful. 
It will also inform you of a short period of time you have to wait before you can attempt to login again 

 

 If you try to use a password that has previously been used, you will see an error message 
 

 If you forget your details, contact an administrator 
 

 If your session times out, refresh the page to log in again 
 

To log out click the ellipsis (three dots) icon at the top right of the dashboard, and click Logout 
 

 
 

To change your password click the ellipsis (three dots) icon at the top right of the dashboard, and click your name. 

You can also view your user information here. To leave this page without making any changes, just click back in 

your browser. 
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1.3 DASHBOARDS 
 

Analytics opens at your Home dashboard. There will be a selection of charts. An administrator can configure which 

dashboards you see, and which charts appear on them. 
 

 
 

To see which dashboards are available to you, click the three line (burger) icon. The menu will expand to display a 

list of dashboards. Dashboards in black text can be expanded by clicking the arrow icon. Dashboards in blue text 

are clickable links. Bold text indicates the dashboard you are currently viewing. 
 

 
 

Charts are contained within ‘cells’ on the dashboard. If you have user permission to create cells, you will see the 

Split icons, and can click them to add new cells to the page. 
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1.4 CHART AND DASHBOARD ACTIONS 
 

A selection of icons will be available to you, based on your user account permissions, and whether you are in 

dashboard or full screen view. Chart actions are only visible when they can be used. 
 

Dashboard icon Description  Chart icon Description 
       

 
Burger Menu containing list of all 

dashboards. 
 

 
Info Help text and chart information. 

 
Search Locate an active category by 

entering a keyword. 
 

 
Full 
screen 

Expand this chart to full screen. 

 
Expand Expand dashboard category to show 

sub-categories. 
 

 
Close Close full screen view. 

 
Filter Apply filters to all charts on the 

current dashboard. 
 

 
Ellipsis Menu containing the following 

items: 

 
Refresh Refresh the current dashboard to 

update data. 
 

 
Drill to 
top 

Return to original chart (top 
level). 

 
Spanner Open CREATE (configuration page 

for administrators). 
 

 
Drill up Drill up one level. 

 
Ellipsis Menu containing the following 

items: 
 

 
Export Export chart data to an Excel 

spreadsheet. 

 
User View user information and change 

password. 
 

 
Cog Open the Edit Chart screen. 

 
Send Send a link to this dashboard by 

email. 
 

 
Refresh Refresh the data for this chart. 

 
Carousel Rotate the display between this 

dashboard and any sub-categories, 
showing each one for a specified 
time. 

 
 

Remove Remove this chart cell from the 
dashboard.  
NOTE: the chart will not be 
deleted, and will still be available 
in the Chart Library. 

 
About Technical information about this 

dashboard. 
 

 
Split Create a new cell by splitting the 

current cell horizontally or 
vertically. 

 
Logout Log out of the Analytics application.  

 
Create Create a new chart. 

    
 

Library Selection of charts available to be 
added to dashboards. 
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1.5 ADD A CHART 

 

To add a chart to an empty cell, or replace an existing chart in a cell, click the Chart Library        icon. A list of available 

charts opens. You can enter a keyword to help find a chart. 
 

 
 

This chart, Outstanding Reports by Modality – Last 3 Months, displays a count (number of unreported events from 

the last 3 months) on the Y axis. Data is ordered by the X axis value (number of days since attendance). Data within 

each day is also grouped (by modality). 
 

Each of these items can be edited to produce a new chart, for example you may wish to see exam count instead of 

event count, or group the data by patient type instead of modality. 
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1.6 FILTERS 
 

You can apply filters to a chart to view a smaller set of data. Any filters applied in the following ways do not affect 

other users, and only remain for this session, or until you reset the chart. Clicking one or more items in the legend 

shows only those events. Deselect items to return to the full chart. 
 

 
 

Dragging the cursor across a section of a chart zooms into the selected range. Click the Reset Zoom button to undo. 
 

 
 

Hover over the data to see more information about that group of events. 
 

 
 

Click on the data to drill down to individual events. Click the Drill Up        icon to return to the original chart.  
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1.7 CREATE A CHART 
 

To create a new chart click the Create new chart        icon. The New Chart screen opens at the Data tab. This is 

where you choose items for the X and Y axes, and a legend, if required. 
 

 
 

Available items are called data connections because they connect to data in CRIS. Items are arranged in groups to 

help you choose the right ones. When you select your first item, subsequent items must be selected from the same 

group of data connections. Only that group will be visible once you make your first selection. 
 

 

To add a Y axis value, click to select the field. It will be highlighted in blue when selected. Because Y axis connections 

have to be a number, only counts will be displayed. 

 

To add an X axis value, click to select the field. It will be highlighted in blue when selected. X axis connections can 

be a number, or any other type of data like a date or exam key. All available connections will be displayed. 

 

To add a legend value, click to select the field. It will be highlighted in blue when selected. Data can be grouped by 

any available connection. Some connections are more suitable than others, for example modality is a good choice 

because it sorts data into a limited number of groups. Event key may not be a good choice because there could be 

a large number of events and the resulting chart will present too much information. 
 

 

To create the chart Outstanding Reports by Modality – Last 3 Months, you could choose the following items from 

the Performers Indicators 3 Months group: 
 

Y axis  Event Count 

X Axis  Days Since Attendance 

Legend  Modality Description 
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Once you choose values, the new chart is displayed in the preview panel on the right. The panel on the left shows 

the ‘drill path’ of this chart – the charts that will be displayed as you drill into the data. The currently displayed (top 

level) chart is highlighted in blue. 
 

 
 

You can choose a chart type on the Chart tab. Bar and column charts can display single and multi-dimensional data. 

Pie charts are good for displaying relative sizes. Pie charts are effective with a single dimension. Changing from a 

bar chart to a pie chart will remove the legend item. Speedometers are useful for real-time monitoring of waiting 

times. 
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Filters can be applied on the Filters tab. Unlike session filters, these will be saved and applied permanently, unless 

they are removed by editing the chart. A number icon indicates how many filters exist. Filters are created using 

data connections, with an operator and a value. For example, you could add Is Verified = f (false) if you want to see 

unverified reports. To remove filters, click each minus        icon. 
 

 
 

Data tables (often the last level of the drill path) can be sorted, by any column values, on the Sorting tab. A number 

icon indicates how many sorts exist. In the image below, data is sorted alphabetically by examination name. To 

remove sorts, click each minus        icon. 
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A drill path can be created on the Attributes tab. You can choose which information from the chart you want to 

keep when you drill. In the image below Modality Description is selected. This means that when you click the chart 

to drill, you will only see the modality you clicked on. If Modality Description is unselected, it doesn’t matter where 

you click on the chart, all modalities will be displayed. 

 

 
 

Each chart on the drill path can be given its own display title. The top level chart will keep its original name, which 

is the name you see in the Chart Library, even if you give it a display title. Lower level charts will display the original 

name, unless you give them a display title in the Chart Title field.  

 

NOTE: If you edit a chart and save it with a new name (not chart title), you should also check your drill chart titles, 

as they will retain their titles from the original chart. 

 

Display titles can be dynamic - changing according to the value you have drilled. For example, the following title will 

change depending which modality you drill: Outstanding {{Modality Description}} Reports – Last 3 Months. Curly 

brackets denote a variable value, in this case modality. Drilling into CT would display a chart with the title 

Outstanding CT Reports – Last 3 Month and drilling into MRI would display a chart with the title Outstanding MRI 

Reports – Last 3 Months.  
 

 
 
You can choose to display Data Values (numbers on each column of data) or a Trend Line (a line showing the 
direction of change).  
 

 
 

You can change the labels that are displayed on the axes and legend. The data connection remains the same, and 
is not renamed. Labels can be hidden by selecting the tick box. 
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On the Targets tab you can add colours to display behind the chart for specified data ranges. A number icon 

indicates how many targets exist. These targets are a visual guide to when personal targets are reached. To remove 

targets, click each minus        icon. 
 

 
 

On the Colours tab you can choose colours for each of the legend items. A number icon indicates how many 

colours have been changed. To return to the default colours, click each minus        icon. 
 

 
 

When you have created a new chart click the Save       icon. If you edit a chart click Refresh       to see changes.  
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CRIS Analytics - CREATE 
 

Analytics is a browser-based application. There are two screens: EXPLORE, where you can view and edit charts, and 

CREATE, where (if you are an administrator) you can configure settings. 
 

2.1 OVERVIEW 
 

In CREATE, categories appear as tabs rather than links. The Object List in the Configuration tab contains: 
 

Data Connections Add data connections to categories to create filters.  
To edit data connections, please contact HSS. 

2.5 CATEGORY FILTERS 

Chart Colours Set default chart colours 2.10 DEFAULT COLOURS 

Users Create new users and edit permissions 2.7 CREATE USERS 

Reports To create reports, please contact HSS.  

Categories Create categories to display as user dashboards 2.5 CREATE CATEGORIES 

Roles Create roles to apply the same settings to a group of users 2.6 CREATE ROLES 

Scheduler Runs View all scheduled runs of charts being sent to users 2.9 SCHEDULING 
 

 
 

Dashboard icon Description 
  

 About Shows the current version of the dashboard software. 

 

Print Print all charts on the current tab. 

 

Rebuild Reset the dashboard to its default settings without logging out. This removes temporary 
filters from charts. 

 

Carousel View all charts as an animated carousel. The carousel can be paused and restarted using 
the video buttons, and closed by clicking the X button. 

 

Refresh Refreshes the current category by re-interrogating the data. It also marks other categories 
as ‘stale’ which means that next time you go into a stale category it will refresh 
immediately. Clicking this will reveal additional options to parameterise how often the 
data will be refreshed. Click the Cycle tabs tickbox to move between category tabs in turn 
on refresh rather than just refreshing the current tab. 

 

Query Click or hover to view droplist filter information. 
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2.2 LOG IN 
 

You can access Analytics CREATE by clicking the spanner icon in EXPLORE. CREATE opens in a new tab. You can 

bookmark this URL and go directly to it for all configuration tasks. If you go directly to the CREATE URL, the Please 

Login dialog appears. If your session times out, refresh the webpage to log in again. To log out, just close the page. 

If you logged via EXPLORE, go to the EXPLORE URL and click the ellipsis (three dots) at the top right, then Logout. 
 

 
 

If this is a brand new installation, then the credentials to log in are:  User Name: admin      Password: dashboard 

At the first log in after installation, you may be asked to enter a new password as the existing one has expired.  

The new password must be at least 6 characters long. NOTE: Passwords are case sensitive. 

 

 
 

If you enter incorrect login details more than once, it will tell you how many times you have been unsuccessful. It 

will also inform you of a short period of time you have to wait before you can attempt to login again. The period of 

time will increase in relation to the number of times you have incorrectly entered login details.  
 

If you try to use a password that has already been used within the last 3 times you have changed the password, you 

will see an error message. The reuse limit of 3 is a global parameter accessed by double-clicking Users in the Object 

List on the Configuration category (last tab on the right). 
 

If you forget your details, contact the administrator, or click [Forgotten Password?] to request a change. The 

dashboard should be configured to use an SMTP server in the Configuration tab Server settings, and ensure your 

users have an email address in the Configuration tab User Details. See 2.7 CREATE USERS 
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2.3 MANAGE PASSWORDS 
 

To open the Change Password window, click the User icon       on the Home tab. If you do not have access to the 

Home tab, you can also change your password by clicking the Change Password icon       in the Toolbar. 

 
 

Global parameters for passwords can be set in the Configuration tab. Double-click the Users folder. 

 
 

The ability to change your own password is also set in the Configuration tab. This can be applied to an individual 
user, or to every user with a particular Role. Double-click a username or role to open their settings tab. 
 

 
 

An administrator can set user passwords to expire in the Configuration tab. This can be applied to an individual 
User, or to every user with a particular Role. If a user forgets their password and does not have an email address in 
their User Details an Administrator will need to set the new password manually. 
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2.4 DASHBOARDS 
 

Analytics opens at the Home dashboard, if the user has access to it. An administrator can choose to hide the Home 

dashboard from users. They may choose to do this if a user does not have any access rights to KPIs or reports.  
 

 
 

Displayed on the Home dashboard are the Glance Panel and several charts. Other charts can be arranged into 

categories, and can be viewed by selecting the category tab. 
 

 
 

There are two pre-configured categories, Home and Configuration, but other categories can be added and edited. 

Categories can also have further sub-category tabs within them in order to make it easier to organise charts within 

the dashboard into suitable sub-groups. 
 

Access to categories and sub-categories is controlled by the administrator. An administrator can decide who has 

access to which categories, and how they are nested. The administrator also controls the default position of the 

tabs. If you wish to (and your access role is not a chart viewer) you can change the order of the tabs by dragging 

and dropping them to a new position. You can also arrange tabs in category settings. See 2.5 CREATE CATEGORIES 
 

A small red arrow will appear to show where you are about to drop the tab. There are exceptions to this: 

- You cannot move the Home tab. It always appears as the first tab 

- You cannot move the Configuration tab. It always appears as the last tab 

- If your role is a chart viewer, your dashboard is returned to the default when you next log in 

 
 

 

 

To add charts to the dashboard see 1.5 ADD A CHART and 2.8 SAVE A CHART 
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2.5 CREATE CATEGORIES 
 

In CREATE, categories form the tabs along the top of the screen. They always start with the Home tab and end with 

the Configuration tab. The order of all categories can be changed, as long as the user has permission, except for the 

Home and Configuration tabs.  

 

 

 

Categories can be visible or hidden dashboards, and are used both to display charts and to apply security settings. 

A parent category cannot display charts of its own if it has child tabs, but its category can still be used for security.  

 

Both charts and users can have categories assigned to them. A chart can belong to a parent category and also 

appear on multiple dashboards. A user only has access to categories added to their Allocated Roles and Categories 

panel. See 2.7 CREATE USERS 

 

- Click the Configuration tab (last tab on the right) 

- Click * next to  Categories in the Object List 

- Give your new category a description (hover text) and a label (name which appears on the tab) 

- Choose a parent category from the droplist* 

- Click       to save 

- Either press F5 to refresh the page (requires logging in again) or click       to rebuild the Dashboard 

 

 
 

*NOTE: You can also create a parent category by dragging and dropping categories onto a folder in the Object List.  
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Category detail Description 
  

Category Description Appears only in tab hover text (Label plus Category Description). 

Label Text that appears on the tab. You can reuse this label on child categories. For 
example, you can have a sub-tab called Today on Radiographer and Radiologist tabs. 

Use as display tab Select if you want this category to be visible. Deselect if you only want to use this 
category for security purposes. 

Lock Prevent other users making changes to this category. 

Parent Category Can be used to move the category to or from a parent category. 

Default Position The order the tab will appear unless a user has dragged it to their own position. 

Manage Category Users Click  to assign users to a category in the Manage Category Users window. 

 

Any category you create is automatically assigned to you. If you want other users to see it, select one or more users 

in the Manage Category Users window. 
 

 
 

NOTE: At this point other users will see a blank dashboard. If you also want users to see charts you place on the 

dashboard, you need to make that layout available to them. See 2.12 PUBLISH A LAYOUT  

 

Category Filters 
 

You can use category filters to apply the same filters to all charts on a dashboard. In EXPLORE you can access 

category filters by clicking the Filter         icon. In CREATE, you can add droplists or sliders to the top of the dashboard. 

 

- Double-click to open the category 

- Click  to expand the   Data Connections folder in the Object List 

- Drag and drop a Data Connection into the Category Objects panel 

- Select a filter type from the droplist 

- Click       to save 
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For example, if you add the Data Connection Modality and select Droplist, this will create a droplist that filters by 

modality on the category tab in CREATE. Cascade Filter Selection means when you select an option from one 

droplist, the next list is limited. For example, if you choose Modality = CT, you can only choose a Radiologist who 

reports CT from the next droplist. 

 

 
 

Droplists will be seen by all users who have access to that category. Droplists allow you to apply a filter to all 

available charts (highlighted in blue when you click a droplist) on the dashboard. To filter all charts (not including 

KPI speedometers), select from the available droplists, for example Patient Type, Site, or Modality.  

 

 
 

By default category objects display as droplists. You can change a droplist to a slider, search list, or number picker. 

A slider allows you to select a range of values. This is particularly useful for date ranges, but can be used for any 

object type. 
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2.6 CREATE ROLES 

 

There are five default roles, with increasing order of authority. 

 

Role Description 
   

 Viewer Can view, drill down, and apply session filters. No changes are saved. 

 User As Viewer, and can add new cells and charts. Changes to layouts are saved for next 
time the user logs in. 

 Explorer As User, and can also edit, but not save, charts. 

 Designer As Explorer, and can create new charts, and alter existing charts. 

 Administrator As Designer, and can set up and alter Configuration parameters. Only users with this 
role will see the Configuration category. 

 

Roles determine which icons a user has in their tools menu in EXPLORE. 

 

 
 

Viewer User Explorer Designer Administrator 
     

Drill Up Drill Up Drill Up Drill Up Drill Up 

Full screen Full screen Full screen Full screen Full screen 

Close Close Close Close Close 

Information Information Information Information Information 

Copy (to Excel) Copy (to Excel) Copy (to Excel) Copy (to Excel) Copy (to Excel) 

Edit Chart Edit Chart Edit Chart Edit Chart Edit Chart 

Refresh Refresh Refresh Refresh Refresh 

New Chart New Chart New Chart New Chart New Chart 

Split Split Split Split Split 

Delete Cell (not chart) Delete Cell (not chart) Delete Cell (not chart) Delete Cell (not chart) Delete Cell (not chart) 

Chart Library Chart Library Chart Library Chart Library Chart Library 
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The tools menu can also be accessed in CREATE. See 2.8 CHART TOOLS for full descriptions. 

 

 
 

Viewer User Explorer Designer Administrator 
     

Print Print Print Print Print 

Send Send Send Send Send 

Export to PDF Export to PDF Export to PDF Export to PDF Export to PDF 

View Data/Chart View Data/Chart View Data/Chart View Data/Chart View Data/Chart 

XML/SQL XML/SQL XML/SQL XML/SQL XML/SQL 

Copy (Excel) Copy (Excel) Copy (Excel) Copy (Excel) Copy (Excel) 

Home Home Home Home Home 

Down/Up Arrows Down/Up Arrows Down/Up Arrows Down/Up Arrows Down/Up Arrows 

Refresh Refresh Refresh Refresh Refresh 

*Library Library Library Library Library 

Edit Edit Edit Edit Edit 

Create Create Create Create Create 

*Split cell Split cell Split cell Split cell Split cell 

*Remove Remove Remove Remove Remove 

Publish Publish Publish Publish Publish 

Full screen Full screen Full screen Full screen Full screen 

Return Return Return Return Return 

Filter Filter Filter Filter Filter 

Key Key Key Key Key 

Target Target Target Target Target 

 

*These options are available in CREATE but not EXPLORE. 
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As well as being able to assign a particular role to a user which dictates the level of their authority (Administrator, 

Chart Designer, Chart Explorer, User, or Chart Viewer) via the droplist on the user tab, you can also create and 

assign one or more custom roles to a user. Roles are defined groups of categories and user privileges. 
 

- Click * next to   Roles in the Object List 

- Enter a Role Description 

- Drag and drop all relevant categories into the Allocated Categories and Roles panel, and select User Privileges 

- Click       to save 
 

 
 

You can then assign the role to multiple users via the Manage Role Users  button. A role can also be assigned 

when creating new users. One or more roles can also be applied to a user by dragging the role into the user’s 

Allocated Categories and Roles panel. See 2.7 CREATE USERS 
 

 
 

For example: 

- Create a role called Reporting Radiologist 

- Add all the categories (reporting dashboards) you want reporting radiologists to see 

- Select the User Privileges you want this role to have 

- Add all reporting radiologists to this role in the Manage Role Users window 
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2.7 CREATE USERS 
 

An administrator can create user accounts with relevant access permissions. You can configure user hierarchy and 

roles. All users are created under the root user Admin. You can also create a ‘parent’ user (for example Local Admin) 

then save users under that parent. A user can only have the permissions available to their parent user. 

 

- Go to the Configuration tab and click to expand   Users  

- Click * next to   ADMIN (or other parent user), in the Users folder, to add a new user 

 
 

 
 

 
 

User Details field Description 
  

Forename, Surname Both fields are mandatory. 

UserCode (login name) UserCode is not case sensitive. It cannot be changed once a user has been created. 

Email Enter an email address if you want the user to receive charts (including scheduled). 

Image File Image File is optional. Enter the name of the file, which should be available in your 
Analytics image folder. 

Role See 2.6 CREATE ROLES  

Individual/Team This is a description and does not change any functionality. 

Parent User Optional. Assigning a group of users to a Parent User enables default values to be 
passed down. 
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User Privileges 

Only an administrator can grant or remove privileges from a user account. However you are only able to grant or 

remove the privileges that you have access to yourself i.e. if you do not have View XML privilege then you will not 

be able to grant this privilege to another user account.  
 

User Privilege Description 
  

 Show Home Page Displays home page. 

 Change Own Password Change own password before it expires. 

 Print Print charts on the dashboard, either individually or all. 

 View XML See the XML used to build any chart to help with diagnosing any problems, 
and within that, the ability to see a performance chart which details how the 
chart is being built, and where the time in milliseconds is being spent.  

 Modify Layouts Add/delete cells. 

 Save Filters Save filter choices in your selected sub-folder of the Defined Filters folder in 
the Object List. 
 

 Edit Data Connections Not available. Please contact HSS for any data connection queries. 

 Edit Charts Change and save existing charts. 

 Edit Users Create, duplicate, edit, delete, move, and synchronize users. You must also 
be an administrator to be able to do this. This option also allows you to edit 
general user configuration. 

 RSS Bar Access to the RSS bar and any news feeds assigned to your dashboard. 
Please contact HSS for any RSS queries. 
 

 Edit Categories Create, edit, or delete categories. You must be an administrator to do this. 

 Edit Server Settings Modify server settings. You must be an administrator to do this. Please 
contact HSS for any server queries. 
 

 Set Charts Anonymous Set charts to be anonymous. You must be a chart designer to do this. 

 Collaborate Email charts via the dashboard. The user account must have a valid email 
address and the SMTP server settings should be configured to match your 
local email settings. Please contact HSS for any collaboration queries. 

 Carousel View charts on a moving carousel which rotates across the screen. This can 
be used where charts are displayed in a public area. 

 Schedule Configure schedule for charts. Allows you to define the email subject, 
message, frequency of the schedule, and recipients of the chart. There are 
options to modify the font and colour of the text and define the size and 
height of the chart as a jpeg image. 
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User privileges are applied using the positive of either users or roles i.e. if on in User Privileges, and off in Role, the 

privilege is on. If off in Users, and on in User Privileges, the privilege is also on. If you want privileges to always be 

applied from Roles, turn off all User privileges. Select checkboxes to assign or remove privileges. 
 

User Privilege Description 
   

 Edit SQL Not available. Amend the SQL on individual charts and change the database 
query being used to build the chart. Please contact HSS for any SQL queries. 

 Save Layouts Save a dashboard layout to make it available to other users. 

 Apply Saved Filters Apply a saved filter from the Defined Filters folder. 

 Edit Default Colours Change and add default chart colours. 

 Edit Reports Create, edit, or delete links to external reports and RSS feeds. You must also be 
an administrator to be able to do this. Please contact HSS for report queries. 

 Edit Variables This privilege should only be given to Admin users as it allows them to add, delete 
and edit User Variables, on the Configuration category, from the user variables 
section of a profile as shown below. Unless a user has also been given the ability 
to Edit Users this privilege will not work. 

 Edit Roles Amend, create, and delete Roles in the Configuration category. Roles are 
specified groupings of categories which can be assigned to users. 

 Audit Access to the Audit category to audit other users of the dashboard and the charts 
created in the Audit category. 

 Charts Bounce Enable or disable the bouncing of charts when a user first logs into the 
dashboard, when the entire dashboard is refreshed and when any changes are 
made to charts. 

 Charts Shaded Enable or disable the chart shading effects that give all charts a three-
dimensional appearance 

 Charts Shadow Enable or disable the shading on all charts on the dashboard for that user. 

 Copy Data Copy the raw data or numbers that sit underneath a chart onto a clipboard and 
then paste that information into another piece of software, such as an email, 
Word or Excel. Can be configured to save automatically as an Excel file. 

 Create PDF Export tables as a PDF documents. This privilege will only work with tables. 
Charts can be exported from the dashboard as jpeg images and scheduled with 
the email privilege (Collaborate). PDF documents can be customised with user 
level or globally defined header logos to tie them into your branding. 

 Edit Own Chart Targets Ability to set targets on a chart without editing the chart itself. The targets will 
recolour the plain background of the chart, behind any bars or lines. This ability 
can be assigned to any level of user but targets will only stick on those charts 
where the user has the appropriate privileges to make changes (Admin, Designer, 
Chart Explorer, and User). 

 Suppress Warnings  
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Security 
 

An administrator can configure user security settings. 

 
 

KPI Links and Chart Targets 
 

An administrator can drag Data Connections into here from the Object List and then add the applicable user code. 
Used to personalise KPIs. For example, if this user is only to see reporting KPIs related to their own performance.  
 

 
 

Allocated Categories and Roles 
 

An administrator can drag categories and roles into this panel from the Object List. This determines which 
categories (dashboards) this user is allowed to view, and which roles they are allocated. You can also drag categories 
into a role, making it easier to add multiple categories to a user, rather than adding them individually. 
 

 
 

User Restrictions 
 

An administrator can drag items into here, from Data Connections in the Object List, and then enter a restriction 
value. This can be used so that a user only sees information for their own role/department without having to create 
separate charts for each of these areas. 

NOTE: Where the administrator wishes to restrict the user on a number of different values in the same field then 
four colons should be used as the delimiter, for example January::::March 
 

 
 

User Variables 
 

An administrator can edit user variables, for example to apply a new style. 
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2.8 CREATE AND EDIT CHARTS 
 

Using CREATE to edit a chart offers an administrator advanced options which are not available in EXPLORE.  
 

Chart Actions 

A chart is contained within a chart cell. Selecting a chart by clicking it will highlight the cell with a green border. 
 

 
 

To resize a chart for easy viewing, click and drag the horizontal  and vertical  resize bars.  
 
 

 
 

On each chart cell there are a set of buttons in the top left corner. Which buttons are available depends on the 

chart and data. Click       to make a chart full screen and view a selection of the following options: 
 

Chart icon Description  Chart icon Description 
       

 

Spanner Open/relocate Toolbar.  
 

Blue Query View chart information. 

 

Home Return to default chart.  
 

Copy Copy data to clipboard. 

 

Refresh Refresh chart.  
 

Funnel View chart filters. 

 

Full screen Full screen window.  
 

Edit Edit selected chart. 

 
Return to chart Exit full screen view.   Create Create a new chart. 

 

Down/Up Arrows Drill down/up a level.  
 

XML View XML data. 

 

View chart data Toggle view.  
 

View SQL data. 

 

Print Print selected chart.  
 

Send Send chart by email. 

 

PDF Export raw data.  
 

Target Set own targets. 
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Chart Tools 

Click the spanner icon to open the Toolbar for the active chart. Once open the Toolbar will slide to any selected 

chart. All popup windows like the Toolbar can be dragged around the screen, and closed by clicking the X button. 
 

 
 

A selection of chart actions will be available to you, based on your user account permissions, and whether you are 

in Chart or Data view. Chart actions are only visible when they can be used. Click a chart to select it, then right-click 

anywhere in the chart to open the Speed Menu. This contains the same options as the Toolbar. 
 

 
 

Toolbar icon Action  Toolbar icon Action 
     

 Print Print current chart.   Edit Edit selected chart. 

 Send Send chart by email.   Create Create new chart. 

 Export to PDF Save raw data as a PDF.   Split cell Add new cell to the right/below. 

  View Data/Chart Toggle view.   Split cell 

 XML View XML data.   Remove Remove chart cell. 

 View SQL data.   Publish Publish chart layout. 

 Copy Save as an Excel file.   Full screen Full screen window. 

 Home Return to default chart.   Return Exit full screen view. 

 Down/Up Arrows Drill down/up a level.   Filter Show filters. 

 Refresh Refresh chart data.   Key Change password, preferences. 

 Library Open Charts Library.   Target Set own targets. 
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Chart Explorer 

All features of charts - type, objects, axes, labels, title, filters, and drill path - can be customised.  

Click Edit Chart       in the Toolbar, full-screen Chart, or Speed Menu to open the Chart Explorer window. 

 

The Chart Explorer window has four panels: Object List, Chart, Edit, and Main Menu.  

 

 
 

Object List 

Contains items you can drag and drop onto your chart, including Types, Objects, Data Connections, and Defined 

Filters to add to your chart e.g. change from a bar chart to a pie chart. 

 

Chart 

Preview your chart and see more detailed information: Drill Path, Help Text, and Links. Drag and drop objects here 

e.g. change X axis value from Appointment Date to Attended Date. 
 

Edit 

Customise your chart e.g. change group colours, set visual target guides. You can also drag and drop objects here. 
 

Main Menu 

Includes Save, Configure Schedule, Print, Drill, Refresh, change PDF Preference, choose Category, and Lock chart. 
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To create a new chart, click  in the Toolbar or Speed Menu. Chart Explorer opens the Chart Panel at the Chart tab 
 

Items from the Object List can be dragged and dropped into the Chart or Drill Path tabs. If an item cannot be 

dropped into a particular area an X icon will display next to the pointer:  
 

Click Search  in the Object Panel to toggle the search function. Enter full stop, asterisk, keyword e.g.  .*vetting 

 

Chart Types 

 

- Click  to expand the Chart Types folder 

- Click to select a chart type e.g. Stacked Bar Chart, Speedometer, Data Table 

- Drag and drop the chart type into the Chart tab 
 

 
 

Chart Types 

  Bar charts and column charts can utilise single and multi-dimensional data. 

 Bar Chart  Column Chart 

 Stacked Bar Chart  Stacked Column Chart 

 100% Stacked Bar Chart  100% Stacked Column Chart 

  Waterfall charts are single dimensional and combine values of all objects and add them together to redraw 
the Y axis. The actual value of the item will not change. The objects will be rearranged to flow downwards. 

 Waterfall Chart  Waterfall Chart 

  Pie charts are good for displaying relative sizes. This chart type is effective with a single dimension. 

 Doughnut  Pie Chart 

  Combined chart (line chart with bar chart) allows you two have two measures on the same chart. 

 Speedometer (see below)  Traffic Light (see below) 

 Gauge  Cylinder 

 Vertical Gauge  Light Bulb 

 Funnel  Map 

 Pyramid  Data Table (see below) 

 Line Chart  Form 

 Area Chart   
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DATA TABLE CHART 

Displays data as a table instead of a graph. Can be exported to Excel. 
 

- Select a chart on the dashboard 

- Click Edit Chart  in the Toolbar, full-screen Chart, or Speed Menu 

- Click a column header. This opens an editing panel above the table 

 

 
 

                Description 

Table 

Data Table is Hierarchical When this tickbox is selected, you can select each column individually and specify if 
it is hierarchical and if you want to show the totals for that column. 

Column Widths are Explicit When this tickbox is selected, you can enter a value in the Width field. 

Show with Data Collapsed Includes the number of items that have been collapsed, next to each of the objects. 

Column 

Do Not Show Header Select to hide the Header name. 

Is Hierarchical When this tickbox is selected, you can expand and collapse a column. When setting 
columns as hierarchical there is the option to Show with Data Collapsed. This allows 
you to build up the table into groupings where data in the first column will be grouped 
as appropriate in relation to data in the second column and so on. 

Show Totals Select this tickbox to show totals for all numeric columns. 

Display as HTML  

Width This value is retained when you save the chart. Saved column widths are a percentage 
of the total size of the screen. The grid will still resize and apply proportional widths 
from the saved column widths. If the table is larger than the available space, scrollbars 
will be created. If a table only fills part of the screen it will show the remaining area as 
white space. 

Formula 

Formula Text  

Calculate by Column  

Insert a Formula Insert a formula column to the left or right of the selected column. 
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SPEEDOMETER CHART 

The Speedometer can be used as a chart type, independent of KPIs. It requires two objects - a measure and a 

dimension. The dimension can be any, but you will notice that this is used to build the spark line, and therefore it 

is typically a time series, although this is not essential. A spark line is a good way to illustrate, for example, waiting 

time fluctuations over a 24 hour period. 

 

- Drag and drop a measure onto the measure label field 

- Drag and drop a dimension onto the spark line hit area 
 

 
 

The Speedometer can be placed into or have its own drill path. You can drill by clicking on the dial. 
 

The trend point for the speedometer is the average of all the points found on the spark line (excluding the latest or 

last value). If a dimension is not provided for the trend line, or there is only one value found, then a spark line will 

not be shown. 
 

If the measure is a KPI then the targets of the KPI will be used. Otherwise you can create or override the targets 

using the Targets tab on the bottom of the screen. 
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TRAFFIC LIGHT CHART 

This chart type is a version of the Speedometer chart type and behaves similarly to other gauge type charts, 

however when swapping to or from this chart type there are particular factors which need to be considered.  
 

The chart will accept one measure object - this is the value which is tested against targets to decide which colour is 

displayed on the traffic light - and one (or no) dimension object - this is the value used to create the spark line. 

Typically this object would be a date, but this is not essential. 

 

Targets are related directly to the chart itself. Any targets set up in the Edit Chart window are applied at a global 

level and will be the same for all users who have access to the chart. If the measure object used in this chart is also 

defined as a KPI, even if the user who views the charts has specific targets created against that KPI, the Traffic Light 

chart’s targets are used instead. The Chart Colours, Labels and Object tabs do not relate to this chart type and will 

therefore not be available. 
 

Drag and drop a measure onto the measure label field, or the gauge, and a dimension onto the spark line hit area. 
 

 
 

Swapping from another chart type to a Traffic Light 

 

If the chart type is another gauge type, then the swap is direct and no additional changes are required. If the chart 

contains a single dimension then the swap does not require any modification; the measure is used for the value, 

and the dimension for the spark line. If a second dimension (i.e. legend/group object) is present then it is discarded 

on the swap. In this case the dimension present on the X axis of the chart is used to produce the spark line. 

 

Swapping from a Traffic Light to another chart type 

 

The resultant chart will always be drawn as a single dimensional chart, and no item will be placed in the legend. If 

no dimension is present in the traffic light then the full chart will not be drawn but will instead be in a state waiting 

to accept the drop of a dimension. 

 

s 
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Chart Objects 

 

- Click  to expand Chart Objects folders 

- Click to select a chart object - Trend Line or Chart Labels 

- Drag and drop the object into the Chart tab 

 

Trend Lines show the direction of change in value over time, for each legend item. In the chart below (DNAs), for 

example, the MRI trend is downwards and the Radiology trend is upwards.  Chart Labels are a count of that group’s 

content. In the chart below, four CTs were performed on 23-11-2016. 

 

 
 

The Object tab displays any objects added to a chart. To remove an object, select the object, then click  
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Data Connections 

 

Data connections are the statistical values available from the CRIS database that can be used to populate a chart. 

Data connections are arranged in groups to help you choose the right ones. When you select your first item, 

subsequent items must be selected from the same group of data connections. Only that group will be visible once 

you make your first selection. 
 

- Click  to expand the Data Connections folder 

- Click  to expand a sub-folder (organised by type of data) in the Data Connections folder 

 

Choose a measure (count e.g. Event Count) for the Y axis, a dimension (type of data that can be split into segments 

e.g. Appointment Date, Radiologist) for the X axis, and item for the legend (group e.g. Modality). 

 
 

- Drag and drop a Data Connection, with a red circle  (a measure), from the Object List onto the Y Axis 

- Drag and drop a Data Connection, with a grey block   (a dimension), from the Object List onto the X Axis 

- Drag and drop a Data Connection (either type) from the Object List onto the legend title 

- Click  to expand the Chart Types folder 

- Enter a Chart Description, and select a Category from the droplist 

- Click  to save 
 

EXAMPLE:  Y axis: Count Unreported, X axis: Attended DateTime, Legend: Modality Description, Type: Stacked Bar 
 

 
 

NOTE: A Data Connection with a red circle and an eye    denotes a measure which is being monitored i.e. KPI. 
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Chart Filters 

 

Defined Filters 
 

Defined filters are created on the dashboard in CREATE. You can save your filter choices to apply again, to this or 

other charts. Filters are saved in your selected sub-folder of the Defined Filters folder in the Object List. Any filters 

you add can be cleared by clicking Home       This will not remove permanent filters. See PERMANENT FILTERS 

 

- Click Show Filters  in the Toolbar or Speed Menu 
 

 
 

- Click Delete   to delete a filter 

- Click Add  to add a new Object field, then choose an object from the Object List window 

- Click Search  to find an item in the Object List. Search will start displaying results from the first letter you 

enter. To find a word in the middle of an object name, enter a full stop and asterisk before the search term. 

- Click [OK] 

OBJECT LIST WINDOW SEARCH OBJECTS 

  
 

- Choose an operator from the droplist e.g. Greater Than 

- Enter a value in the Value field or click Search  for a list of values to choose from 

- Click [Apply] 

- Click [      Save]  to save your filters 

- In the Save Filters window, enter a name and description, and choose a category (tab) 
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Permanent Filters 
 

You can apply filters to the top level of a chart in the Filters tab of the Chart Explorer window. Any changes applied 

here will remain in place once you save this chart, and will not be affected by SESSION FILTERS or DEFINED FILTERS. 
 

- Click Edit Chart  in the Toolbar, full-screen Chart, or Speed Menu 

- Drag the resize bar to expand the Edit panel at the bottom of the screen, and view the Filters tab 

- To edit an existing filter field, drag an object from the Object List panel into the field you wish to replace 

- To add a new filter field, drag an object from the Object List panel into the field with a red asterisk 

- Click Delete   to delete a filter 

- Choose an operator from the droplist e.g. Equal To, Between, Greater Than 
 

 
 

- Enter a value in the Value field, or click Search  to select from available values in the Search window 

- Select one value’s checkbox 

- Click [OK] 

- Click Refresh  in the Main Menu panel to view your changes 

- Click [      Save] to save the edited chart 
 

 
 
NOTE: If certain operators are applied to a measure or KPI object, then the value will be evaluated on the aggregated 
value. The aggregate consideration applies to Less Than, Greater Than, and Between. 
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Edit Filters 
 

You can edit filters in the Filters tab of the Chart Explorer window. Any changes applied here will remain in place 

once you save this chart, and will not be affected by SESSION FILTERS or DEFINED FILTERS. 
 

 
 

- Enter a value in the Value field, or click Search  to select from available values in the Search window 

- Select one value’s checkbox 

- Click [OK] 

- Click Refresh  in the Main Menu panel to view your changes 

- Click [      Save] to save the edited chart 

 

Filter operator Description 
  

Equal To/Different From Returns values where there is/is not an exact match. Case sensitive. 

Less Than Returns values where the value is less than/less than or equal/greater 
than/greater than or equal to the entered criterion. Applies to dates and numbers.  

Less Than or Equal To 

Greater Than 

Greater Than or Equal To 

Between When using Between/Not Between an extra field becomes available to enter both 
the required criteria. Includes/excludes rows that fall within the range specified. 

Not Between 

In List Type a list of criteria that the value should match/not match. The list must be in 
brackets. Criteria should be in single quotes, separated by a comma. For example 
(‘Verified’,’Unverified’,’Unprocessed’) Not In List 

Like Type an underscore or asterisk as a wildcard. For example _verified would return 
verified and unverified. *ABDO* would include/exclude CABDO and CABDOC. 

Not Like 

Top Returns the top X axis values. For example if the X axis is clinicians and the Y axis is 
the number of unreported events, selecting 5 will return the top 5 clinicians by 
their number of unreported events. 

 

- To apply a previously saved Defined Filter to your chart, click  to expand the Defined Filters folder in the 

Object List 

- Drag and drop a Defined Filter onto your chart 
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Session Filters 
 

Session filters are not saved. To filter a chart by group, click single or multiple legend values e.g. Fluoroscopy and 

Nuclear Medicine. To remove filters and return to the original chart, click Home       
 

 
 

To filter by the X axis value, click in an unoccupied part of the chart. The pointer changes to a funnel   

Drag the funnel across the section of data you wish to view. The yellow box indicates your selected range of data.  
 

 
 

When you stop dragging, the chart zooms to your selected range. Hover over any part of the data to view more 

detailed information. The pointer changes to a magnifying glass       to show that you can drill down into this chart. 
 

 
 

Click any part of the data to drill down to the next level. The final level is the raw data which populates the chart. 

Click Up  to go up one level in the drill path, or Home       to return to the original chart.  
 

 
 

Another way to temporarily filter data shown in a chart is to drag a section, or a particular segment from a pie chart, 

onto another chart. For example, drag a name from Reported by Radiologist to Outstanding Reports by Modality. 
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Parent/Child Filters 
 

Instead of dragging a data element from one chart to another to filter it, you can set a chart to be a parent chart, 

and by interacting with it, it will apply filters to all other charts on the category (tab). 
 

- Click Edit Chart  in the Toolbar, full-screen Chart, or Speed Menu 

- Select the Parameters tab in the Chart Panel 

- Select the Parent Chart checkbox 

 

 
 

NOTE: Once a chart has been defined as a parent chart, its drill path is not taken into account. When you click on a 

section of a chart, or slice of a pie chart, or a row if it is a data grid, then the selected item will be applied as a filter 

to all of the other charts shown on the dashboard. 

 

When a chart is a parent chart as it will have the Parent      icon in the chart cell. When you apply filters to this chart, 

they will be applied to other charts on the dashboard. You can create as many parent charts as you like on a page, 

and use combinations of charts and tables. If the parent chart contains a legend item, then you can click on the 

legend to filter all other charts. To remove filters click Home       on the parent chart. 

 

Sorts 

 

- Drag and drop an item (a dimension i.e. X axis or legend) from the Data Connections folder in the Object List 

- Select the A-Z or Z-A button 

- Click Refresh  to sort the order of the grouped items 
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Colours 

 

This tab displays data groups (the chart legend), and the colours assigned to them. You can edit both the legend 

items and their colours. See also 2.10_DEFAULT COLOURS 
 

- Choose an Object (the legend name) from the droplist e.g. Modality Description 
 

- If you just want to edit the colours of existing groups, click the colour buttons to choose a colour for each group. 
The same colour can be used for multiple groups, if required e.g. both Fluoroscopy and Interventional 
modalities could be the same colour 

 

- If you want to edit which groups appear on the legend, click Search       to select a value from the list of available 
options for each field 

 

- Change an operator if required e.g. Equal To, Between, Greater Than 
 

- Click  Refresh to apply your changes 
 

 
 

Chart Axis Labels 

 

This tab displays any custom axis labels added to a chart. The value (data connection name) remains the same, but 

the display name can be changed. In the image below the value = Appointment Date, but the label = ‘My custom X 

axis label’. If you select the Hide checkbox, the custom label is displayed in Chart Explorer, but not on the dashboard. 
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Targets 

 

This tab displays any targets added to a chart. You can set targets for reporting, appointing etc. These display behind 

the data in a chart. Targets can be just a visual guide, or you can schedule an email to share your chart when a 

target is reached e.g. when there are over 100 unreported exams. See also 1.7 CREATE A CHART - TARGETS  

 

 
 

Help Text 

 

In this tab you can enter the text that displays when you hover over, or click, the blue query button on a chart. It 

could display, for example, a description of the chart’s output and its drill path. 
 

 
 

Links 

 

This tab allows you to link associated charts together via buttons on the chart. For example, you could have eight 

charts in a category, but only display four on the dashboard at a time, and click buttons to toggle between them. 

Remember that when you link chart A to chart B, you must also create a link from chart B back to chart A so that 

each chart has a button. When you have created the links, select Buttons on Chart in the Parameters tab. See 

PARAMETERS below. 
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Parameters 

 

This tab allows you to set chart parameters. See table below. 
 

 
 

Parameters item Description 
  

 Unique Identifier Click [edit] to change the chart’s unique number/name. 

 
Anonymous Chart Select the tickbox to make this chart anonymous. 

 Buttons On Chart Add a Links buttons to the bottom of the chart. 

 Filter Button On Chart Add a Filter button to the top of the chart. 

 
Parent Chart Select to make this a Parent Chart. Defined Filters applied to this chart will be 

applied to other charts on the same dashboard.  
See PARENT/CHILD_FILTERS 

 Include Nulls  

 Use As List  
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Main Menu 

 

There are further chart options in the Main Menu panel. 
 

 
 

 

Main Menu item Description 
  

 Floppy disk Save a chart, and any changes made. 

 Schedule Send a chart via email to one or more recipients, either once, or at regular intervals. 
See 2.9 SCHEDULING 

 

Print Print the Chart tab. 

 

Down/Up Arrow Drill down or move up one level. 

 

Refresh Refresh chart data. To update to the latest data from the RIS, or to see the results of 
changes made to the chart e.g. new filters applied. 

 

Data/Chart Toggle between chart and data views. 

 

XML View XML data. 

 

View SQL data. 

 PDF Select PDF preference: Portrait or Landscape orientation. 

 

Padlock Password protect the chart to prevent other users from copying or saving the chart. 
Select the ‘Prevent open’ tickbox to prevent other users from viewing the chart. 

Chart Category To move a chart, select a category (tab) from the droplist. 

Chart Description Title which appears above chart. 

Max Rows Limit the rows when designing charts so that the process is faster. 
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Create a Drill Path 

 

A ‘drill path’ is the order and type of steps Analytics takes, when you click a chart to drill into the data, to display 
the results of your query. The Drill Path tab shows how a chart will behave when drilled. Each step (box in the 
diagram) is called a drill node. The last node contains the columns which are shown at raw data level.  
 

 
 

- Drag and drop a Chart Type onto the chart icon .  You can choose a different Chart Type for each level 

- Drag and drop a Data Connection into any field. A Data Connection can be added as an axis value, a legend 

value, or a column in the raw data (final node) 

- Drag and drop a Data Connection into the Title field. Use {{Two Curly Brackets}} to make case-sensitive  

- Select the Drill tickbox to include an item in the next step 

- Click the       icon to add a new node 

- Rearrange columns using the red arrows to the right of the scroll bar 

- Select the       icon to make this level open in full screen when you drill down into the chart 
 

In the example below, for the top level chart Unreported less than 2 weeks old, the next level drills down to reporting 
clinicians. The title changes to Unreported by Modality: {{Modality Description}} for that level. The final level 
includes Intended Radiologist because the Drill tickbox is selected. 
 

 



 
 

 
© Healthcare Software Solutions 2017  All Rights Reserved Commercial In Confidence 
Effective Date – ESM 21/11/2017   
HSS Doc ref:  CRIS_CRIB601_Analytics_Manual_V1.0.docx  Page 49 of 54 

 

 

Save a Chart 

  

When you have finished editing or creating a chart, click the Save      icon. If you edited an existing chart but didn’t 

rename it, the Chart Explorer window will close and the chart will be refreshed.  
 

If you edited a chart and saved it with a new name, or created a brand new chart, your new chart will automatically 

replace any existing chart in the cell. The previous chart will still be available in the Chart Library. 
 

To make charts easier to find and understand, each chart should be given a name in the Chart Name box, and 

assigned to a category in the dropdown list. This also acts as a security feature as only users who have been 

allocated access to the relevant category will be able to see and access the chart. 
 

To add your new chart to a dashboard, you can drag it from the Chart Library onto a cell. See also 1.5 ADD A CHART 
 

Delete a Chart 

 

Charts can only be deleted from the Chart Library. You must have Admin user permissions to delete a chart.  
 

- Click Library   in the Toolbar 

- Click the Charts accordion bar to display its contents 

- Click  to expand a list, or  to collapse it 

- Hover over a chart, then click the icon   that appears 

 

 
 

If the chart is in use you will receive a warning message before you confirm or cancel the deletion. For users who 

were using a chart that you delete there are two possible scenarios: 
 

1. If the user was not logged in at the time then, next time they log in, the chart space formerly occupied by the 

deleted chart will be filled instead by the first chart published to the relevant page category 
 

2. If the user is still logged in, then the deleted chart will still be on their page. When they try to refresh or use the 

home button they will receive an error message 
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2.9 SCHEDULING 

 

You can schedule the sending of a chart via email, for example a weekly list of outstanding reports to clinicians.  

 

- Click Configure Schedule  in the Main Menu panel 

- Select the ‘Chart schedule is active’ checkbox 

- Enter a message subject, and the text which will be used as the email message to accompany the scheduled 

item. This can be formatted using the standard formatting buttons below the field 

 

MESSAGE TAB SCHEDULE TAB 

 

 
 

Schedule Item Description 
  

Preserve Previous Values Select how many historic schedules you want to retain. 

Refresh Every [number] [frequency] Define how frequently you want to refresh the schedule. 

Between Hours Drag the sliders to select the hours between which you want the 
schedule to run. 

Days Of Week Select checkboxes for all the days you want the schedule to run. 
If no checkboxes are selected the schedule will run every day. 

 

View graph View a graph of daily scheduled jobs. 

 

View this schedule View the schedule runs for this chart. 

 

View all schedules View all schedule runs. 

 

- Add the names of Analytics users you want to send the chart to by selecting some, or all, checkboxes. If you 
want to email anyone without an Analytics account, please see your system manager 

 

- Click [      Save] 

- To view all schedule runs, click the red clock icon         either here or in the Object List panel 
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RECIPIENTS TAB SCHEDULER RUNS 

 

 

 

 

2.10 DEFAULT COLOURS 

 

This screen is used to change the default chart colours.  Users can also edit their own chart colours without affecting 

the default colours. See 1.7 CREATE A CHART - COLOURS 

 

- Go to the Configuration tab 

- Double click  Chart Colours 

- Select a colour, or type a hex value 
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2.11 ADD A CHART 
 

Click Library    in the Toolbar to display all of your Charts, Filters, KPI, and Layouts, in tree view. Here, you will 

find a selection of custom-made charts that you can use. If the Library is opened via the Speed Menu, the Toolbar 

also opens beside the Library window. Toolbar actions are only applied to the selected chart behind this window, 

not the charts in the library. See also 1.5 ADD A CHART 
 

 
 

- Click an accordion bar to display its contents 

- Click  to expand a list, or  to collapse it 

- Drag and drop an item into any cell, new or occupied 

- If you have administrator permissions, you can click   to delete an item 

 

2.12 PUBLISH A LAYOUT 

 

Click Publish  in the Toolbar to publish a new layout (how the charts are arranged on your dashboard). Other 

users with access to the same dashboard will see the layout if you make it the default. See 2.12 SET AS DEFAULT 
 

- Enter a description, and choose a destination category (tab) from the droplist  

- Click [Save] or, to exit without saving, click [Close] 
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APPLY A LAYOUT 
 

Choose a new layout, to apply to your dashboard, from the Chart Library by dragging an item from the Layouts 

section and dropping it anywhere on the page. This will overwrite the current layout. To restore the default layout 

drag the layout with the selected checkbox back onto the page.  
 

 
 

SET A DEFAULT LAYOUT 
 

Select the checkbox to set the default layout for this category. Non-admin users with access to the same dashboard 

will see the layout if you make it the default, otherwise they will see a blank dashboard, or their own layout. 
 

 
 

PREVIEW A LAYOUT 
 

Before applying a layout you can view it as it would appear on the category. Click the full screen icon 
 

DELETE A LAYOUT 
 

If you have admin or chart designer user privileges then you can delete a layout by clicking Delete   
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